
 

 

 مثالی از طراحی یک بروشور زیبا در کورل دراو )تصویری و گام به گام(

 

 

پیاده سازیست را با هم طی خواهیم قابل  A4در این آموزش مراحل ایجاد یک بروشورتاشوی جالب که بر اساس قالب ساده 

 قالب ساده به این معناست که می توانید آن را به صورت حرفه ای یا به سادگی در خانه چاپ کنید.. کرد

https://design.tutsplus.com/tutorials/how-to-create-a-colorful-brochure-for-print-using-coreldraw--cms-23604


 

 

این بروشور می تواند برای رویدادهای تبلیغاتی یا جذب بازدیدکنندگان بسیار کارآمد باشد چرا که با طراحی انعطاف پذیر و  

لایه های راحت روی هم قرار می گیرند و پخش طیف کاملی از رنگها در سراسر آن چشم هر بیننده ای را به کاملی که دارد، 

 خود جلب می کند.

 

 Corelبرای اکثر بخشها و  CorelDRAW، یعنی CorelDRAW Graphics Suiteاز مجموعه  ما از دو برنامه کاربردی

PHOTO_PAINNT تفاده خواهیم کرد.برای ویرایش تصاویر در طی مسیر اس 

 بیایید شروع کنیم!

 چطور بروشور را تا کنیم-1

 دو طرفه چاپ خواهد شد. A4بروشور به صورت یک برگه 

 جلوی بروشور

 

 پشت بروشور



 

 

 

جهت تا به سمت داخل و خطوط مشکی خط چین نشان می دهد. خطوط مشکی پیوسته را بروشور  نحوه تا شدنزیر  تصویر 

 را نشان می دهند. جهت تا به سمت بیرون

 جلو



 

 

 

 

 پشت



 

 

 



 

 

 

 تنظیم قالب بروشور در کورل دراو-2



 

 

 

 گام اول

 یک سند جدید ایجاد کنید.را انتخاب کرده تا  New، گزینه Fileمنوی  از کورل دراو را باز کرده و

، Height گزینهت راست متنظیم کنید. در س A4را روی  اندازهو  Fold-Out Brochureروی سند یک نام بگذارید، مثلا 

قرار دهید و  2را هم  Number of Pages تعداد برگه ها یا .در آورید Landscapeبه حالت افقی یا جهت برگه را 

تنظیم شده اند. در  dpi300 روی  Rendering Resolutionو  CMYKروی  Primary Color Modeمطمئن شوید 

 این صورت سند برای چاپ بهینه شده است.



 

 

 

 کلیک کرده تا سند ایجاد شود. OKروی دکمه 



 

 

 

 گام دوم

را روی لایه فعال کنید. با این کار تصویر به  bleedگزینه اگر قصد دارید بروشورتان را برای چاپ حرفه ای ارسال کنید، باید 

 تر از لبه صفحه ادامه می یابد و باعث می شود خطاهای جزئی پیرایش پس از چاپ به حداقل برسد. آنطرف

بروید. در پایین پنجره، می توانید  Page Setupبه  Layoutاز منوی در لایه کورل دراو، bleed برای اضافه کردن گزینه 

را  Show bleed areaقرار دهید و داخل مربع کنار  5.0را روی مقدار  Bleedرا ببینید.  bleedگزینه های مربوط به 

 کلیک کنید. OKهم تیک زده و روی 



 

 

  

 



 

 

 

 ومگام س

 .بیایید صفحات بروشور را نامگذاری کنیم تا حین کار بدانیم روی کدام قسمت داریم کار می کنیم

سند را نمایش می  Page 2و  Page 1می توانید دو برگه یا تب که  (Workspaceدر پایین سمت چپ فضای کار )

را به  Page 2و  Frontرا به  Page 1را برای هر کدام بزنید.  Rename Pageدهند را ببینید. راست کلیک کرده و 

Reverse .تغییر دهید 

 



 

 

 

خواهند کرد جایی  را ایجاد کنیم که به ما کمک بروشور، بیایید مجموعه ای از خطوط راهنما Frontماندن در صفحه ضمن 

 بروشور نهایی در آنجا تا خواهد خورد را ببینیم.که 

کردن  dragنزدیک به نوار ابزار قرار گرفته و  فضای کارسمت چپ در  ی کهمی توانید با کلیک کردن روی خط کش

 خطوط راهنما ایجاد کنید. به سمت راست صفحه، )کشیدن(

 

به صورت دستی برای وارد کردن اندازه دقیق  میلیمتر بکشید. می توانید 99یک خط راهنما از خط کش دست چپی به طول 

)اگر  تایپ کنید که در بالای سمت چپ فضای کار قرار دارد Property Bar در نوارخط راهنما  X position قسمت در

 را فشار دهید(. Ctrl+Enterاین نوار به طور پیشفرض نمایش داده نشده کلیدهای 



 

 

 

 

. خط سوم را با بین این دو خط بخش میانی بروشور نمایش داده می شودمیلیمتر بکشید.  198خط راهنمای دوم را با اندازه 

 .کنندبخشهایی که قرار است تا شوند را مشخص می  میلیمتر بکشید. این خطوط 247.5ارمی را با میلیمتر و چه 49.5 اندازه



 

 

 

رفتید، یادتان باشد که کورل دراو به صورت خودکار این  Reverseاگر خواستید به پشت بروشور نگاهی بیندازید و به صفحه 

 برگردید. Frontقبل از اینکه مجددا شروع به کار کنید، به صفحه جلویی یا  خطوط را در پشت بروشور هم اعمال کرده است.

 ایجاد دنباله ای از لایه ها-3

 گام اول

یه ها در یک سند کار شما را برای ویرایش و سازماندهی آسانتر خواهد کرد. شما می توانید اطلاعات لاایجاد دنباله ای از  

 که منتهی الیه سمت راست فضای کار قرار گرفته پیدا کنید. Object Managerمربوط به لایه ها را در پنل 



 

 

 

 

 کلیک کرده تا باز شود. Object Managerروی تب  



 

 

 

ایجاد شده است. با انتخاب  Object Managerنامگذاری شده قبلا در پنل  Guidesتوجه داشته باشید لایه ای که 

New Layer است، لایه جدید دیگری با نام از منوی آبشاری در گوشه بالای سمت رImages  را بسازید که زیرGuides 

ایجاد کنید. در آخر نوبت به  Colored Shapesلایه بعدی را با نام بسازید.  Colorقرار خواهد گرفت. یک لایه جدید با نام 

 گیرد.قرار می  Guidesمی رسد که در بالای همه لایه ها به جز لایه  Typographyایجاد لایه 



 

 

 

 گام دوم

قفل شود بجز لایه  هر لایهکلیک کنید تا  Object Managerروی آیکون مداد در سمت چپ نام هر لایه در پنل 

Images.روی آن کلیک کرده تا فعال شود . 



 

 

 

 گردآوری تصاویر روی بروشور-4

از میان شکافهای بین اشکال رنگی می خواهیم محتوای تصویری را در پشت رنگ و متن قرار داده طوریکه بخشهایی از تصاویر 

 دیده شوند.

ودنشان عالی ب پذیرقبل از هر چیز، عکسی انتخاب کنید که زمینه بروشور شما باشد. تصاویر مناظر به خاطر تطبیق پذیری و دل

 هستند.

 گام اول

را فشار دهید(. تصویری از ساحل دریا را انتخاب  Ctrl+Iبروید )یا  Importبه  Fileاز منوی ، Imagesضمن فعال بودن لایه 

 کلیک کنید. Importو روی 

تصویر را طوری قرار دهید که تقریبا از قسمت مستطیل باریک سمت چپ تا بخش میانی ادامه داشته باشد و در بالای تصویر 

 از لبه بالایی عبور کند )همانند تصویر زیر(.



 

 

 

د تا به صورت افقی برگردانده شود، ، آن را روی خودش بکشیرا بگیریدا چپ تصویریکی از علامتهای مربعی سمت راست ی

 سمت چپ تصویر قرار گیرد. یطوریکه شهر کنار ساحل در گوشه بالای



 

 

 

زی به یک سوم بالایی عکس نداریم چرا که در صفحه جا نخواهد توجه داشته باشید که تصویر بسیار بلند است و ما واقعا نیا

 گرفت.

از درون برنامه کورل دراو، ویرایش بخشهای مختلف عکس و ویژگیهایی مانند رنگ  Corel PHOTO-PAINTبا باز کردن 

در نوار منو کلیک کرده و  Bitmapsنیز بسیار ساده است. عکس ساحل را با مکان نمای موس انتخاب کرده سپس روی 

Edit Bitmap… .را از منوی آبشاری انتخاب کنید 



 

 

 

 باز می شود. Corel PHOTO-PAINTر پنجره جدید تصویر د

 

 را فشار دهید(. Dرا از نوار ابزار سمت چپی انتخاب کنید )یا کلید  Crop Toolابزار 



 

 

 

موس خود را در دو سوم پایینی تصویر بکشید تا ناحیه آسمان آبی بالای ابرهای متراکم که روی شهر ساحلی قرار گرفته اند را 

 جدا کنید.

 



 

 

 صفحه کلید ضربه بزنید تا تصویر بریده شود. Enterروی کلید 

 

دستکاری  Corel PHOTO-PAINTهمچنین می توانید در صورت تمایل رنگ تصویر را هم با استفاده از افکتهای موجود در 

 کنید.

 بروید. Vibranceدر بالای فضای کار به  Adjustی منواز 



 

 

 

 افزایش دهید. %13را تا  Saturationو  %33تا  Vibranceسطح  برای بیشتر آفتابی جلوه دادن تصویر،

 

در منتهی الیه سمت  Finish Editingو کار تمام شد، روی دکمه  روی تصویر پیاده کردیداهتان را وویرایش های دلخ وقتی

 کلیک کنید. Property Bar ارراست در نو



 

 

 

 کلیک کنید. Yesروبرو شدید، روی گزینه  ذخیره تغییراتاگر با پیام 

 

حالا شما به سند بروشور کورل دراو بازگشته اید و تصویرتان بیشتر برش خورده و با صفحه تناسب بیشتری دارد. مهم نیست 

 فراتر رفته اند، این مسئله روی نتیجه چاپ نهاییتان تاثیری نمی گذارد. Bleedکه هنوز هم بخشهایی از تصویر از خط 

 

 گام دوم



 

 

کنید. آن را آن طرف در سمت راست صفحه قرار دهید و ابزار  Edit ،copy & Pasteاز منوی خاب کرده و تصویر را انت

Crop Tool  ازToolbox  را انتخاب کنید.در سمت چپ فضای کار 

 

 247.5میلیمتر و  198تصویر را طوری ببرید که فقط یک بخش از عکس نمایان باشد، یعنی فضای بین خط راهنمای 

 )بخش دوم بروشور از سمت راست(. میلیمتر



 

 

 

 پالت رنگ خیره کنندهایجاد -5

قرار است بروشور ما مملو از رنگهای طیف گرم )نارنجی، قرمز، صورتی( و سرد )سبز لیمویی، ارغوانی، فیروزه ای، آبی( باشد. 

 بیایید پالت رنگی در کورل دراو برای استفاده روی لایه آماده کنیم.

 گام اول

 کنید. بازرا  Colorیعنی  کنید. لایه بعدی قفلرا  Imagesبرگردید و لایه  Object Managerبه 



 

 

 

را انتخاب کنید. می توانید  با  Color Palette Manager ، گزینهDockersاز منوی  رفته و Windowدر نوار منو به 

کلیک روی آیکون + که بین پالتهای رنگ و میانبرهای لیست شده در منتهی الیه سمت راست فضای کار یافت می شود، به 

 ( هم دسترسی داشته باشید.Dockersتمام میانبرها )



 

 

 

باز  Save As. پنجره کلیک کنید Create a New Empty Color Paletteروی آیکون  Palette Managerدر 

 Saveاختصاص دهید و روی  Beach Brochure Color Paletteیک اسم قابل تشخیص مانند  پالتمی شود به 

 کلیک کنید.



 

 

 

را انتخاب ( Beach Brochure Color Paletteپالت سفارشی که ساخته اید ) Color Palette Managerدر 

 برای باز کردن یک پنجره جدید کلیک کنید. Open the Palette Editorروی آیکون کنید. 



 

 

 



 

 

 

Add Color  را در بین گزینه های موجود در پنجرهPalette Editor .انتخاب کنید 

ایجاد کنید. این ترکیب رنگ به شما رنگ سبز لیمویی خوشرنگی خواهد  C=26 M=0 Y69 K=0با مقادیر  CMYKیک رنگ 

 .به پالت رنگ اضافه شودکلیک کنید تا  OKبگذارید و روی  Lime Greenنام رنگ را مثلا  ،Nameداد. در قسمت 

Add Color  را دوباره انتخاب کنید و برای شش رنگ بعدی همین روند را تکرار کنید و مقادیر و نامهایشان را به صورت زیر

 انتخاب کنید:

 C=0 M=89 Y=41 K=0  )مرجانی( 

 C=76 M=11 Y=34 M=0  (سبز )فیروزه ای 

 C=0 M=69 Y=69 K=0  )نارنجی( 

 C=3 M=83 Y=0 K=0) )صورتی( 

 C=69 M=0 Y=0 K=0  )آبی( 



 

 

 C=88 M=87 Y=0 K=0  )ارغوانی( 

 



 

 

 

 گام دوم

 را فشار دهید(. F6انتخاب کنید )یا  Toolboxرا از  Rectangle Toolابزار 



 

 

 

 49.5به مقیاس تا خط راهنما  صفحه رویی )از قسمت حاشیه سمت چپ یکه در میان اولین بخش بیرون ی ایجاد کنیدشکل

 ادامه پیدا کند. در حاشیه لبه های بالا و پایین صفحهکشیده شده باشد و میلیمتر( 

 Fill و مرجانی  رنگ روی راStroke  را رویNo Color .تنظیم کنید 



 

 

 

 

 

 

این شکل دوم را روی بخش منتهی الیه سمت کنید.  Edit ،Copy & Pasteاز منوی  شکل مستطیلی را انتخاب کرده و

تنظیم  سبز فیروزه ایرا روی  Fillی سمت راست(. یانتهامیلیمتر و لبه  247.5راست صفحه قرار دهید )بین خط راهنمای 

 کنید.



 

 

 

 معرفی شکلهای ژئومتریک ساده -6

 گام اول

 کنید. بازرا هم  Colored Shapesه بالایی یعنی کنید؛ لای قفلرا  Colorبروید و لایه  Object Managerبه 

Basic Shapes  ازToolbox  را انتخاب کرده و توجه داشته باشید نوارProperty Bar  که در بالای صفحه کار قرار

از گزینه های وسط نوار  مثلثرا ارائه می دهد. شکل شکلهای پایه گرفته این بار گزینه های متفاوتی مربوط به ابزار 

Property Bar .را انتخاب کنید 

 

 هدبا یک نقطه از مرکز سمت چپ سند کشیده ش طوری باشد که کلیک کرده و موس را روی صفحه بکشید، شکل مثلث باید

 )همانند شکل زیر(. پیدا کندمیلیمتر ادامه  198و تا لبه صاف روی خط راهنمای 



 

 

 

گزینه ، قرار دارد Object Managerر و نزدیک به که در سمت راست فضای کا Object Properties در قسمت

Outline  را رویNone .تنظیم کنید 

 

 

 تغییر دهید. سبز لیموییبه  Fillبا مثلث را  رنگ



 

 

 

 گام دوم

روی خودش بکشید تا به صورت افقی را شده  Pasteمثلث سبز را کنید و سپس از نقطه منتهی الیه سمت چپ شکل 

 برگردانده شود.

Fill  تغییر دهید. این مثلث دوم را زیر اولین مثلث سبز رنگ قرار دهید تا با جای گرفتن در کنار هم )همانند  نارنجیرا به

از لحاظ اندازه با هم منطبق شوند، کمی ناهماهنگی هم شکل زیر( یک شکل لوزی نامتقارن تشکیل شود. لازم نیست دو مثلث 

 بد نیست!

 کنید.تنظیم راحت تر ، اندازه و شکل مثلثها را Convert to Curvesبا راست کلیک کردن و کلیک روی 



 

 

 

 گره های شکل را دستکاری کنید. ،صفحه کلید F10همچنین می توانید با ضربه زدن روی 



 

 

 

تنظیم  صورتیرا روی  Fill، سومین مثلث را هم ایجاد کنید. Editاز منوی  مثلث نارنجی رنگکردن  Copy & Pasteبا 

 کنید.

 

مقابل قسمت بالایی شکل سبز و روبروی لبه تصویر ساحل  باشد  ،مثلثمثلث را به پشت بکشید و سپس آن را طوریکه نقطه 

 قرار دهید.



 

 

 

و آن را بکشید تا باریکتر شود. سپس مثلث جدید را زیر مثلث نارنجی رنگ  Edit ،Copy & Pasteمثلث سبز را از طریق 

 تغییر دهید. رنگ آبیرا به  Fillار دهید تا به خوبی زیر آن جای گیرد و تا لبه سمت راست صفحه کشیده شود. قر

 



 

 

 گام سوم

 را بردارید. Toolboxاز  Two-Point Line toolابزار 

مودی خط عبا موس روی صفحه چپ کلیک کرده، دکمه موس را پایین نگه داشته و به سمت پایین بکشید و رها کنید تا یک 

 کوتاه ایجاد شود.

 



 

 

 میلیمتر قرار گیرد. 49.5آن را در سمت چپ صفحه قرار دهید طوریکه روی لبه مثلث سبز با مقیاس خط راهنمای 

 

شده را طوری قرار دهید که خط به  Pasteکنید. اشکال  Copy & Pasteمثلث سبز و خط را با مکان نما انتخاب کرده و 

 قرار گیرد. به صورت افقی میلیمتر 247.5طور کامل روی خط راهنما با 



 

 

 

خط دو نقطه ای روی دو طرف چپ و راست صفحه را پاک کنید؛ ما از اینها فقط به عنوان راهنما استفاده کردیم. حالا وقتی 

 دیده می شود.بروشور را تا کنیم، شکل مثلثی بدون درز و یکپارچه 

 تنظیم کنید. رنگ آبیشده را روی  Pasteمثلث 



 

 

 



 

 

 

 گام چهارم

یک شکل مثلثی دیگر ایجاد کنید. همانطور که در تصویر نشان داده شده آن را طوری قرار دهید که شکاف موجود در سمت 

در نوار   Angle of Rotationتغییر دهید. در صورت لزوم می توانیدرنگ صورتی را به  Fillراست صفحه را پر کند و 

Property Bar  بچرخد.درجه  د تا شکل مثلثیتان مانند تصویر زیر دهی غییرا تر 

 



 

 

 

 Typographyمعرفی لایه -7

خوانا روی بروشور باید طرح حروفی را انتخاب کنید که حروف در آن بدون زائده و برای ایجاد یک متن مدرن، چشمگیر و 

 ایجاد می کند.انعطاف پذیری  که کمیاست و ضخامتهای بسیاری دارد  پذیریک انتخاب دل  Fira Sansواضح باشند.

 گام اول

قفل ، آن را Colored Shapesبروید و با کلیک بر روی آیکون مداد در سمت چپ عنوان لایه  Object Managerبه 

کنید تا دایره قرمز  بازنزدیک به نام لایه را هم با کلیک روی آیکون مداد  Typographyکنید. لایه بعدی بالای آن یعنی 

 رنگ روی مداد حذف شود.



 

 

 

و موس را بکشید تا قاب متن جدیدی در مرکز صفحه ایجاد  را فشار دهید( F8را انتخاب کنید )یا کلید  Text toolابزار 

گزینه های موجود در  در اندازه فونتتنظیم کرده و  Fire Sans Normalرا روی فونت را تایپ کنید و  VISIT THEشود. 

 تنظیم کنید. پوینت 110روی را  ،در بالای فضای کار Property Barنوار 

 

 تنظیم سفیدرا پیدا کرده و آن را روی  رنگ فونتدر پایین سمت چپ فضای کار می توانید  پالت رنگاز مجموعه رنگهای 

 کنید.



 

 

 

 

اندازه فونت را را تایپ کرده و  BEACHکنید طوریکه زیر اولی قرار گیرد.  Edit ،Copy & Pasteاز منوی قاب متن را 

 تنظیم کنید. پوینت 160روی

 60برابر با  اندازه فونتی را با THIS SUMMERقرار گیرد و  BEACHکنید طوریکه زیر  Pasteیک قاب متن دیگری را 

 تایپ کنید. پوینت



 

 

 

 گام دوم

 EXPLORE NATUREرا فشار دهید( و در آن  F8قاب متن دیگر ایجاد کنید )یا کلید یک  Text toolبا استفاده از ابزار 

 باشد.سفید  رنگ فونتو  پوینت 65آن اندازه فونت را تایپ کرده طوریکه 

را هم هایلایت  NATUREتنظیم کنید؛  Fira Sans Mediumرا روی  فونترا هایلایت کرده و  EXPLOREفقط کلمه 

 تنظیم کنید. Fira Sans Normalرا روی  فونتکنید و 



 

 

 

درجه  90قرار دارد و درج مقدار  Property Barکه در بالای  Rotationقاب متن را انتخاب کنید، سپس از طریق آیکون 

 در آن، قاب متن را به سمت بالا بچرخانید.

 

لبه صفحه و متن وجود دارد مناسبی بین  فاصلهقاب متن را در گوشه پایین دست چپ صفحه قرار داده و مطمئن شوید 

 )نگذارید متن در قسمت حاشیه صفحه بیفتد(.



 

 

 

داخل  Property Barکنید. در نوار  Copy & Paste، آن را Editاز طریق منوی سپس قاب متن را انتخاب کرده و 

برگردانده شود. آن را در گوشه بالای سمت شده  Pasteدرجه پر کنید تا قاب متن  180-را با عدد  Rotationآیکون 

 تغییر دهید. DISCOVER ADVENTUREاست قرار دهید و متن را به ر



 

 

 

 گام سوم

 قسمت رویی بروشور را با هر مقدار متنی که می خواهید پر کنید. 

 Firaکه روی فونت  VISIT THE BEACH THIS SUMMEDمن یک عنوان فرعی کوچک زیر عنوان  ،در این قسمت

Sans ترازبندی را از نوار  پوینت تنظیم 22اندازه  و( و راست چین شده است قرار دادمToolbar .)تنظیم کنید 



 

 

 

به زیر تصویر ساحل در سمت راست صفحه  پوینت 22و اندازه  Fira Sans Italicمن یک عنوان کوچک هم با فونت 

 صورت راست چین قرار داده ام.



 

 

 

میلیمتری( قرار داده ام  49.5همچنین یک بخش کوچک از متن را داخل مثلث نارنجی رنگ )در سمت راست خط راهنمای 

 است و چند کلمه اول آن را به رنگ سبز لیمویی درآوردم. پوینت 22و اندازه اش  Fira Sans Normalکه فونت 



 

 

 

 گام چهارم

یک قاب متن جدید  Text Toolبرای افزایش جلوه چاپی بروشورتان، جزئیات بیشتری را به آن اضافه کنید. با استفاده از ابزار 

 Fira( و فونت را Exploreرا به صورت بزرگ تایپ کنید )حرف اول  Eرا فشار دهید(. فقط حرف  F8ایجاد کنید )یا 

Sans Normal  هید.قرار د پوینت 400و اندازه را 

 تنظیم کنید. سبز لیموییرا روی  رنگ فونتآن را در گوشه بالایی سمت چپ صفحه قرار دهید و 



 

 

 



 

 

 

شده را در گوشه پایینی سمت راست صفحه  pasteکنید. این قاب متن  Copy & Pasteآن را قاب متنی را انتخاب کرده و 

 تغییر دهید.آبی را به  فونترنگ ( تایپ کرده و Discoverبزرگ )حرف اول  Dقرار دهید. حرف 

 

 تکمیل پشت بروشور-8

جلوی  برایتا حالا به پشت بروشور کاری نداشته ایم، اما نگران نباشید طراحی اش به اندازه جلو زمان نمی برد. حالا که 

 به عنوان قالبی برای پشت استفاده کنیم. آن ، به سادگی می توانیم از ه ایملایه ایجاد کرد بروشور



 

 

 ولگام ا

 کنید.باز تمام لایه ها را با کلیک بر روی آیکون مداد واقع در سمت چپ نام هر لایه،  Object Managerدر 

 

انتخاب کنید. را  Objectsگزینه  Select All از قسمت رفته و Editسپس، مانند جلوی بروشور، در نوار منوی بالا به 

 اشکال رنگ شده و قابهای متنی را بر می دارد.کورل دراو تمام اشیا موجود در صفحه مانند عکسها، 

 سند دسترسی پیدا کنید. صفحه پشتیروی تب واقع در پایین فضای کار کلیک کنید تا به 

خواهند شد. به درون گروه ها بروید و  Paste. اشیا در دنباله ای از گروه ها کلیک کنید Pasteروی  Editاز طریق منوی 

منتقل  صفحه پشتیدر  Typographyیا  Images ،Color ،Colored Shapesیعنی  اختصاصیشانآنها را به لایه 

 .کنید

 حالا شما یک کپی کامل از هر چیزی که در صفحه جلویی داشتید، در صفحه پشتی هم دارید.

 گام دوم

 رها کنید. بازرا  Imagesکرده و لایه  قفلرا  Colorو  Typography ،Colored Shapesلایه های 

 Corelتوانیم رنگ تصاویر را سیاه سفید کنیم. شما می توانید با استفاده از  ایجاد ظاهری متفاوت در پشت بروشور، میبرای 

PHOTO-PAINT .این تصویر را ویرایش کنید 

را وارد کنید که واقعا برای اجرای عملیات ویرایشی روی عکس مفید و  Corel PHOTO-PAINTمی توانید از کورل دراو 

 است.سریع 

 بالا را با مکان نما انتخاب کنید. ابتدا، تصویر ساحل

 را از منوی آبشاری انتخاب کنید. …Edit Bitmapکلیک کرده و  Bitmapسپس از نوار منو روی 



 

 

 

 باز می شود و می توانید مستقیما روی تصویر تغییراتی را اعمال کنید. Corel PHOTO-PAINTیک پنجره داخل برنامه 

رنگ تصویر را غیر اشباع کنیم تا به صورت سیاه سفید تغییر پیدا کند. برای انجام  Grayscaleما می توانیم با اعمال افکت 

 .کلیک کنید Grayscaleرفته و روی  Adjustمنوی به  Corel PHOTO-PAINTاین کار، ضمن ماندن در پنجره 



 

 

 



 

 

 

 کلیک کنید. OKنگه دارید سپس روی تنظیمات پیش فرض روی را  ای که باز می شود، اسلایدرها Grayscaleدر پنجره 



 

 

 

 

 در منتهی الیه سمت راست نوار ابزار کلیک کرده تا بلافاصله به محیط کورل دراو بازگردید. Finish Editingروی دکمه 

 



 

 

 حالا تصویر به صورت سیاه سفید آپدیت شده است.

 

 گام سوم

کرده و آن را بالاتر از عکس در سمت راست صفحه قرار دهید. سعی کنید  Copy & Pasteتصویر سیاه سفید ساحل را 

برای اصلاح لبه های تصویر که نامرتب روی هم قرار گرفته اند استفاده  Crop Toolبهترین مکان را انتخاب کنید. از ابزار 

 کنید.



 

 

 

 گام چهارم

کنید. اشیای موجود در لایه  بازرا هم  Colorکنید. لایه بعدی یعنی  قفلرا  Imagesلایه  Object Managerاز طریق 

 را از یک گروه خارج کنید تا بتوانید آنها را جداگانه ویرایش کنید.



 

 

 

 تغییر دهید. صورتیو مثلث دست راستی را به  رنگ مستطیل دست چپی را به سبز فیروزه ای

 



 

 

 گام پنجم

را  Colored Shapesکنید. اشیا واقع در لایه بازبالایی آن را  Colored Shapesکرده و لایه قفل را  colorلایه 

Ungroup .کنید 

برای رنگ آمیزی باقی اشکال مثلثی در پشت بروشور، می توانید از رنگهای پالت سفارشی که در ابتدا ایجاد کردید استفاده 

 بی برخوردار باشند.کنید طوریکه رنگها در مقایسه با صفحه رویی بروشور از تضاد خو

 

 گام ششم

 کنید. باز( سند را Reversepageدر صفحه پشتی )یا  Typographyکرده و لایه  قفلرا  Colored Shapesلایه 

در مرکز صفحه تنظیم کنید. اندازه آن را هم تقریبا بزرگ انتخاب کنید طوریکه  HOW DO I GET HEREمتنی با جمله 

 بین دو خط راهنمای مرکزی صفحه جای گیرد.



 

 

 

ی فضای کار، فونت را روی در بالا Property Barبخشهای متنی بیشتری در گوشه های مختلف صفحه ایجاد کنید. از نوار 

Fira Sans Normal  تنظیم کنید. ترازبندی متن را هم چپ چین انتخاب کنید.  پوینت 22و اندازه را روی 

کرده و رنگ آن را هم از پالت رنگی که قبلا ساخته ایم به سلیقه خودتان متضاد با پس  توپرچند کلمه اول هر بخش متنی را 

 زمینه متن انتخاب کنید.



 

 

 

تی از فهرس و ، طرف پشتی جای مناسبی برای ارائه نقشهاگر بروشور را برای یک رویداد یا جذب بازدیدکننده طراحی می کنید

 دستورات هم هست.

اگر دوست دارید، لایه بروشوری که ساخته اید را طوری طراحی کنید تا چیز منحصر به فردی از کار در آید. چرا با تصاویر، 

را برای یک رویداد موسیقی،  ای مختلف امتحان نمی کنید؟ محتویات بروشور را تغییر داده و آنفونتها و ترکیب رنگه

 بازگشایی یک گالری یا رویداد خیریه طراحی کنید.

 بسیار خب! کار به پایان رسید! بروشورتان کامل است و عالی به نظر می رسد!

و همچنین بررسی اینکه هر تمام کاری که لازم است انجام دهید، شاید چاپ چرک نویس و بررسی نهایی خطاهای املایی 

و خیلی به حاشیه نزدیک نشده باشد. اگر نمی توانید لبه حاشیه را ببینید، مسیر نبوده متنی خارج از محدوده 

View>Show>Bleed .را طی کنید و در صورت لزوم موقعیت هر قاب متنی را تنظیم نمایید 

 پخروجی گرفتن از طرحتان به عنوان یک فایل آماده برای چا-9

توجه: اگر می خواهید فایلتان را در خانه و با پرینتر خانگی یا اداری جوهر افشان چاپ کنید، می توانید مستقیما از کورل دراو 

 Printer'sو  Bleedمقادیر شده تان بدون  PDFفایل  و از را طی کرده File>Exportآن را پرینت بگیرید یا مسیر 

marks .خروجی بگیرید 

 نشان می دهند. را خروجی گرفتن از یک فایل آماده چاپ برای پرینتهای حرفه ایمراحل زیر روش 

 گام اول



 

 

را از فهرست گزینه ها انتخاب کنید. نام  PDFدر پایین پنجره،  Save as Type. از منوی آبشاری بروید File>Exportبه 

 .Fold-Out-Brochure_PRINT-READYمناسبی برای فایلی که قرار است از آن خروجی گرفته شود بگذارید، مثلا 

 کلیک کنید. Exportروی 

 

 گام دوم

 را انتخاب کنید. Prepressگزینه  PDF preset، از منوی آبشاری Generalدر قسمت 



 

 

 

 را انتخاب کنید. CMYKگزینه  Output colors asاز منوی آبشاری  Colorدر قسمت 



 

 

 

 را علامت بزنید. Printer's marksتنظیم کرده و تمام  5.0mmرا روی  Prepress ،Bleed Limitدر قسمت 



 

 

 

قرار دارد. در  Issues در PDF Settingsنرم افزار کورل دراو دو نسخه نیرومند درباره سند ارائه کرده است که در منوی 

اندازه رابطه با  در برنامه بگیرید،  PDFخروجی با فرمت  برای نمایش دیجیتال )روی نمایشگر( اگر بخواهید از فایلاین مورد 

 با مشکلاتی همراه خواهد بود.فونتی برخی از متنها 

برای چاپ خروجی بگیریم، جای نگرانی نیست. اگرچه شما باید همیشه قبل از خروجی  PDFاست از فایل  رجا که ما قراناز آ

ن شوید هیچ یک از نسخه های ارائه شده را بررسی کنید تا مطمئ Issuesگرفتن از فایل آماده چاپ در کورل دراو، پنجره 

 روی کیفیت فایل نهایی اثر نخواهند گذاشت.

 کلیک کنید. OKبسیار خب! اگر آماده خروجی گرفتن هستید روی 

 مهیا و آماده ارسال به پرینتر است. Prepress PDFحالا بروشور شما با فرمت 



 

 

 

 



 

 

یک بروشور رنگارنگ  Corel PHOTO-PAINTم که چطور می توان با استفاده از کورل دراو و دیدر این آموزش ما متوجه ش

 .ردو آن را برای چاپ آماده ک ساختبا کیفیت بالا 

 به شما این امکان را می دهند تا با CorelDRAW Graphics Suiteاین دو برنامه همه کاره به عنوان بخشی از مجموعه 

 ، بروشورهای پویا و چشمگیری را در جهت بازاریابی و مقاصد دیگر طراحی کنید.متن، تصایر، اشکال و رنگها به کارگیری



 

 

  



 

 

 

 


